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Introduction
The Microsoft Office Specialist (MOS) certification program has been designed to
validate your knowledge of and ability to use programs in the Microsoft Office 2016
suite of programs. This book has been designed to guide you in studying the types of
tasks you are likely to be required to demonstrate in Exam 77-730, “Access 2016: Core
Database Management, Manipulation, and Query Skills.”

Who this book is for
MOS 2016 Study Guide for Microsoft Access is designed for experienced computer
users seeking Microsoft Office Specialist certification in Access 2016.
MOS exams for individual programs are practical rather than theoretical. You must
demonstrate that you can complete certain tasks or projects rather than simply answer
questions about program features. The successful MOS certification candidate will have
at least six months of experience using all aspects of the program on a regular basis; for
example, using Access at work or school to create and manage databases, build database tables, import and export data, design and run queries, create and format forms,
and design detail and summary reports.
As a certification candidate, you probably have a lot of experience with the program
you want to become certified in. Many of the procedures described in this book will
be familiar to you; others might not be. Read through each study section and ensure
that you are familiar with the procedures, concepts, and tools discussed. In some
cases, images depict the tools you will use to perform procedures related to the skill
set. Study the images and ensure that you are familiar with the options available for
each tool.
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How this book is organized
The exam coverage is divided into chapters representing broad skill sets that correlate
to the functional groups covered by the exam. Each chapter is divided into sections
addressing groups of related skills that correlate to the exam objectives. Each section
includes review information, generic procedures, and practice tasks you can complete
on your own while studying. We provide practice files you can use to work through
the practice tasks and result files you can use to check your work. You can practice the
generic procedures in this book by using the practice files supplied or by using your
own files.
Throughout this book, you will find Exam Strategy tips that present information about
the scope of study that is necessary to ensure that you achieve mastery of a skill set
and are successful in your certification effort.

Download the practice files
Before you can complete the practice tasks in this book, you need to copy the book’s
practice files and result files to your computer. Download the compressed (zipped)
folder from the following page, and extract the files from it to a folder (such as your
Documents folder) on your computer:
https://aka.ms/MOSAccess2016/downloads
IMPORTANT The Access 2016 program is not available from this website. You should purchase
and install that program before using this book.

You will save the completed versions of practice files that you modify while working
through the practice tasks in this book. If you later want to repeat the practice tasks,
you can download the original practice files again.
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The following table lists the practice files provided for this book.
Folder and objective group

Practice files

Result files

MOSAccess2016\Objective1

Access_1-1.xlsx

Access_1-1_results.accdb

Create and manage
databases

Access_1-2.accdb

Access_1-2_results.accdb

Access_1-3.accdb

Access_1-3_results.accdb

Access_1-4.accdb

Access_1-4_results.accdb

Access_1-5.accdb

Access_1-5_results.accdb

MOSAccess2016\Objective2

Access_2-1a.accdb

Access_2-1_results.accdb

Build tables

Access_2-1b.accdb

Access_2-2_results.accdb

Access_2-1c.txt

Access_2-3_results.accdb

Access_2-1d.accdb

Access_2-4_results.accdb

Access_2-2.accdb
Access_2-3a.accdb
Access_2-3b.xlsx
Access_2-4.accdb
MOSAccess2016\Objective3

Access_3-1.accdb

Access_3-1_results.accdb

Create queries

Access_3-2.accdb

Access_3-2_results.accdb

Access_3-3.accdb

Access_3-3_results.accdb

MOSAccess2016\Objective4

Access_4-1.accdb

Access_4-1_results.accdb

Create forms

Access_4-2.accdb

Access_4-2_results.accdb

Access_4-3.accdb

Access_4-3_results.accdb

Access_4-3a.png
MOSAccess2016\Objective5

Access_5-1.accdb

Access_5-1_results.accdb

Create reports

Access_5-2.accdb

Access_5-2_results.accdb

Access_5-3.accdb

Access_5-3_results.accdb

xi

Introduction

Adapt procedure steps
This book contains many images of user interface elements that you’ll work
with while performing tasks in Access on a Windows computer. Depending on
your screen resolution or program window width, the Access ribbon on your
screen might look different from that shown in this book. (If you turn on Touch
mode, the ribbon displays significantly fewer commands than in Mouse mode.)
As a result, procedural instructions that involve the ribbon might require a little
adaptation.
Simple procedural instructions use this format:
➜ On the Home tab, in the Sort & Filter group, click the Filter button.
If the command is in a list, our instructions use this format:
➜ On the Home tab, in the Sort & Filter group, click Advanced Filter
Options and then, in the Advanced Filter Options list, click Filter By
Form.
If differences between your display settings and ours cause a button to
appear differently on your screen from how it does in this book, you can easily
adapt the steps to locate the command. First click the specified tab, and then
locate the specified group. If a group has been collapsed into a group list
or under a group button, click the list or button to display the group’s commands. If you can’t immediately identify the button you want, point to likely
candidates to display their names in ScreenTips.
The instructions in this book assume that you’re interacting with on-screen
elements on your computer by clicking (with a mouse, touchpad, or other
hardware device). If you’re using a different method—for example, if your
computer has a touchscreen interface and you’re tapping the screen (with
your finger or a stylus)—substitute the applicable tapping action when you
interact with a user interface element.
Instructions in this book refer to user interface elements that you click or
tap on the screen as buttons, and to physical buttons that you press on a
keyboard as keys, to conform to the standard terminology used in documentation for these products.
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Ebook edition
If you’re reading the ebook edition of this book, you can do the following:
■

Search the full text

■

Print

■

Copy and paste

You can purchase and download the ebook edition from the Microsoft Press Store at:
https://aka.ms/MOSAccess2016/detail

Errata, updates, & book support
We’ve made every effort to ensure the accuracy of this book and its companion content.
If you discover an error, please submit it to us through the link at:
https://aka.ms/MOSAccess2016/errata
If you need to contact the Microsoft Press Book Support team, please send an email
message to:
mspinput@microsoft.com
For help with Microsoft software and hardware, go to:
https://support.microsoft.com

We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most
valuable asset. Please tell us what you think of this book by completing the survey at:
https://aka.ms/tellpress
The survey is short, and we read every one of your comments and ideas. Thanks in
advance for your input!
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Stay in touch
Let’s keep the conversation going! We’re on Twitter at:
https://twitter.com/MicrosoftPress
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Taking a Microsoft Office Specialist exam
Desktop computing proficiency is increasingly important in today’s business world.
When screening, hiring, and training employees, employers can feel reassured by
relying on the objectivity and consistency of technology certification to ensure the
competence of their workforce. As an employee or job seeker, you can use technology certification to prove that you already have the skills you need to succeed, saving
current and future employers the time and expense of training you.

Microsoft Office Specialist certification
Microsoft Office Specialist certification is designed to assist students and information
workers in validating their skills with Office programs. The following certification paths
are available:
■

■

■

A Microsoft Office Specialist (MOS) is an individual who has demonstrated
proficiency by passing a certification exam in one or more Office programs,
including Microsoft Word, Excel, PowerPoint, Outlook, or Access.
A Microsoft Office Specialist Expert (MOS Expert) is an individual who has taken
his or her knowledge of Office to the next level and has demonstrated by passing Core and Expert certification exams that he or she has mastered the more
advanced features of Word or Excel.
A Microsoft Office Specialist Master (MOS Master) is an individual who has
demonstrated a broader knowledge of Office skills by passing the Word Core
and Expert exams, the Excel Core and Expert exams, the PowerPoint exam, and
the Access or Outlook exam.
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Selecting a certification path
When deciding which certifications you would like to pursue, assess the following:
■

The program and program version(s) with which you are familiar

■

The length of time you have used the program and how frequently you use it

■

Whether you have had formal or informal training in the use of that program

■

Whether you use most or all of the available program features

■

Whether you are considered a go-to resource by business associates, friends,
and family members who have difficulty with the program

Candidates for MOS certification are expected to successfully complete a wide range
of standard business tasks. Successful candidates generally have six or more months
of experience with the specific Office program, including either formal, instructor-led
training or self-study using MOS-approved books, guides, or interactive computer-based
materials.
Candidates for MOS Expert and MOS Master certification are expected to successfully
complete more complex tasks that involve using the advanced functionality of the program. Successful candidates generally have at least six months, and might have several
years, of experience with the programs, including formal, instructor-led training or selfstudy using MOS-approved materials.

Test-taking tips
Every MOS certification exam is developed from a set of exam skill standards (referred
to as the objective domain) that are derived from studies of how the Office programs
are used in the workplace. Because these skill standards dictate the scope of each
exam, they provide critical information about how to prepare for certification. This
book follows the structure of the published exam objectives.
See Also For more information about the book structure, see “How this book is organized” in
the introduction.
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The MOS certification exams are performance based and require you to complete
business-related tasks in the program for which you are seeking certification. For
example, you might be presented with a document and told to insert and format
additional document elements. Your score on the exam reflects how many of the
requested tasks you complete within the allotted time.
Here is some helpful information about taking the exam:
■

■

■

■

■

■

■

Keep track of the time. Your exam time does not officially begin until after you
finish reading the instructions provided at the beginning of the exam. During
the exam, the amount of time remaining is shown in the exam instruction
window. You can’t pause the exam after you start it.
Pace yourself. At the beginning of the exam, you will receive information about
the tasks that are included in the exam. During the exam, the number of completed and remaining tasks is shown in the exam instruction window.
Read the exam instructions carefully before beginning. Follow all the instructions provided completely and accurately.
If you have difficulty performing a task, you can restart it without affecting the
result of any completed tasks, or you can skip the task and come back to it after
you finish the other tasks on the exam.
Enter requested information as it appears in the instructions, but without
duplicating the formatting unless you are specifically instructed to do so. For
example, the text and values you are asked to enter might appear in the instructions in bold and underlined text, but you should enter the information without
applying these formats.
Close all dialog boxes before proceeding to the next exam item unless you are
specifically instructed not to do so.
Don’t close task panes before proceeding to the next exam item unless you are
specifically instructed to do so.
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■

■

■

If you are asked to print a document, worksheet, chart, report, or slide, perform
the task, but be aware that nothing will actually be printed.
Don’t worry about extra keystrokes or mouse clicks. Your work is scored based
on its result, not on the method you use to achieve that result (unless a specific
method is indicated in the instructions).
If a computer problem occurs during the exam (for example, if the exam does
not respond or the mouse no longer functions) or if a power outage occurs,
contact a testing center administrator immediately. The administrator will
restart the computer and return the exam to the point where the interruption
occurred, with your score intact.

Exam Strategy This book includes special tips for effectively studying for the Microsoft Office
Specialist exams in Exam Strategy paragraphs such as this one.

Certification benefits
At the conclusion of the exam, you will receive a score report, indicating whether you
passed the exam. If your score meets or exceeds the passing standard (the minimum
required score), you will be contacted by email by the Microsoft Certification Program
team. The email message you receive will include your Microsoft Certification ID
and links to online resources, including the Microsoft Certified Professional site. On
this site, you can download or order a printed certificate, create a virtual business
card, order an ID card, review and share your certification transcript, access the Logo
Builder, and access other useful and interesting resources, including special offers from
Microsoft and affiliated companies.
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Depending on the level of certification you achieve, you will qualify to display one of
three logos on your business card and other personal promotional materials. These
logos attest to the fact that you are proficient in the applications or cross-application
skills necessary to achieve the certification. Using the Logo Builder, you can create a
personalized certification logo that includes the MOS logo and the specific programs
in which you have achieved certification. If you achieve MOS certification in multiple
programs, you can include multiple certifications in one logo.

For more information
To learn more about the Microsoft Office Specialist exams and related courseware,
visit:
http://www.certiport.com/mos
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Microsoft Office Specialist
Exam 77-730

Access 2016: Core
Database Management,
Manipulation, and
Query Skills
This book covers the skills you need to have for certification as a Microsoft
Office Specialist in Access 2016. Specifically, you need to be able to complete
tasks that demonstrate the following skills:
1

Create and manage databases

2

Build tables

3

Create queries

4

Create forms

5

Create reports

With these skills, you can create, populate, and manage the types of databases
most commonly used in a business environment.

1

Exam 77-730: Access 2016: Core Database Management, Manipulation, and Query Skills

Prerequisites
We assume that you have been working with Access 2016 for at least six months and
that you know how to carry out fundamental tasks that are not specifically mentioned
in the objectives for this Microsoft Office Specialist exam.
The certification exam and the content of this book address the processes of designing and building Access databases. We assume that you are familiar with the Microsoft
Office ribbon and that you understand basic Access features—for example, that you
know how to enter and edit data. We also assume you are familiar with the definition
and function of relational databases and database objects such as tables and forms. To
provide context and an opportunity for review, the following list provides brief explanations of five important terms:
■

■

2

Table Defines the data stored in a database. Tables are composed of fields, and
each field is defined as a specific data type (text, number, date, or another data
type). Each field also has certain properties. For example, you can specify that
a field is required. You can also define the size of a field (such as the maximum
number of characters a field can contain). Users of a database fill in fields (and
must fill in required fields) with values to create a record in the database. In
most tables, each record is identified by a unique value called a primary key,
which might be a single field (such as a product ID) or a combination of fields.
Relationship Helps maintain the integrity of the information in a database and
reduce data redundancy. You can create several types of relationships between
tables in an Access database. In a one-to-many relationship, a record in one
table can be related to one or many records in another. You can also create oneto-one relationships and many-to-many relationships. Relationships are created
by linking a table’s foreign key (such as a customer ID field in an order table)
with another table’s primary key (the customer ID field in the customer table).
Relationships protect data integrity by preventing you from creating orphan
records (for example, an order with no customer). Relationships help reduce
data redundancy by letting you store information in separate tables that you
link together. For example, you can create a customer table and then relate each
order in an order table to the record for a specific customer. This prevents you
from having to enter a custom record for each separate order.

Exam overview

■

■

■

Query Can be used to select records that meet specific criteria and to perform actions such as updating a group of records. To build a select query, you
add fields from one or more tables and then define criteria that Access uses to
retrieve the records you want to view. For example, you might want to retrieve
records with a certain value in a date field (all records created after 1/1/2017, for
example) or records associated with a specific project. Using criteria, you can
also create and run action queries that insert, update, or delete selected records.
Form Used to display, enter, and edit data. Forms are often bound to tables (or
to queries) that serve as the form’s record source. Forms use controls such as
text boxes, check boxes, and list boxes to provide a user interface for a database.
Forms can also be used to confirm and execute database operations and to
navigate from one database object to another. Access provides several built-in
form designs, a gallery of form controls, and tools you use to design and lay out
a form.
Report Used to share and present data and to summarize data for a specific field
or fields. You might print reports for a meeting or distribute them electronically as
PDF files or in email.

3
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Objective group 1

1

Create and manage
databases
The skills tested in this section of the Microsoft Office Specialist exam for
Microsoft Access 2016 relate to creating and managing databases. Specifically,
the following objectives are associated with this set of skills:
1.1

Create and modify databases

1.2

Manage relationships and keys

1.3

Navigate through a database

1.4

Protect and maintain databases

1.5

Print and export data

Many of the operations and tasks involved in creating and managing Access
databases originate in the Backstage view. For example, the New page includes
templates that you can use to create a database, and a search box that you can
use to locate other templates. The Info page provides commands that help you
maintain and protect a database. Beyond the specific commands you use, Access
also offers a way to back up a database, which is a critical step in ensuring that
data is available in the event of an accident or a security incident. By taking steps
to make database navigation clear and logical, you help ensure that the database’s users have an easy time keeping the data current.
This chapter guides you in studying ways to create and modify databases, manage
relationships and keys, navigate through a database, protect and maintain a database, and print and export data.

To complete the practice tasks in this chapter, you need the practice files
contained in the MOSAccess2016\Objective1 practice file folder. For more
information, see “Download the practice files” in this book’s introduction.
5

Objective group 1

Create and manage databases

Objective 1.1: Create and modify databases
When you start Access without opening a recently used database or double-clicking a
database file, the program opens to its startup screen. The startup screen displays a list
of recent files and a set of thumbnails for templates on which you can base a variety of
desktop databases or Access web apps (a type of database stored in the cloud). Access also
provides an option for creating a blank desktop database or a custom (blank) web app.

Database templates such as the Task Management template provide a set of database objects you can build on

This topic provides details about how to create a blank desktop database, how to
create a database from a template, how to import data to build a database, and how
to delete a database object.
Tip On the General page of the Access Options dialog box, you can set options for the default
file format for a blank database and the default database folder.

Create databases
Access databases are made up of database objects: tables, queries, forms, reports, and
supporting objects such as macros. Templates provide some or all of the database
objects you need to manage the type of data the template is designed to support.

6

Objective 1.1: Create and modify databases

When you create a blank database, Access provides a single table by default. You
can set up and define other database objects to expand the databases you create. By
default, Access names new database files by using Databasen, where n is a number
such as 1 or 2. You can enter a more descriptive name when you create the database.

1

Access provides templates for desktop databases and for what Access calls SharePoint
web apps. (The thumbnails for web apps display a globe.) When you work with an
Access web app, you work in a web browser, but you design and modify the web app
in Access. You can share the data in a web app by using an instance of SharePoint.
Exam Strategy Exam 77-730, “Access 2016: Core Database Management, Manipulation, and
Query Skills,” does not require you to demonstrate that you can create an Access web app.

A blank desktop database opens with the Navigation Pane open. In a blank database,
Access creates a default table, called Table1, which serves as a starting point. Access
displays the default Table1 in what Access refers to as Datasheet view. When a table
is displayed in Datasheet view, you can define field names and data types and insert
records. You can also display a table in Design view. In Design view, you work directly
with the structure of the table (the table’s field names and properties) instead of with
the records stored in the table.

The Navigation Pane and Datasheet view of the default table in a blank desktop database

See Also For more information about how to display objects in the Navigation Pane, see
“Display objects in the Navigation Pane” in “Objective 1.3: Navigate through a database.”
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The database templates represented by the set of thumbnails that appears on the
startup page are not the only database templates you can use. At the top of the
startup window is the search box, with the prompt “Search for online templates,” and
just below the search box are suggested search terms. You can search by using one of
the suggestions or enter the search term you want to use in the search box to locate
other templates that might be available.
When you select a thumbnail for a database template on the startup screen, Access
displays a window that provides a description of the template.

Use the arrows that appear to the left and right of this window to browse through the set of templates

In most cases, when the new database opens, Access displays a table or opens a form
for data input. Other objects in the database appear in the Navigation Pane. The Task
Management desktop template, for example, includes tables that define records for
contacts and tasks. This template also includes several queries used to analyze the
data, forms for working with tasks and contacts, and several reports.
Tip Access 2016 includes the Northwind Traders sample database, which has been part
of Access for many versions of the program. The Northwind Traders database provides
examples of features, including a login dialog box, sample macros, and Microsoft Visual Basic
for Application (VBA) modules. Use the search box to find the Northwind Traders database
template (the thumbnail identifies the database as Northwind 2007 sample). Create the
database, and then refer to it when you’re looking for a solution, or just work with it from
time to time to gain an understanding of the extent of the work you can do in Access.
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To create a database from a template
1. On the startup screen or the New page of the Backstage view, click the thumbnail for the template you want to use.

1

Tip Use the search box to locate a template that’s not displayed. To create a blank
desktop database, click the Blank Desktop Database thumbnail. (Depending on your
installation of Access, the template might be named Blank Database or Blank Desktop
Database.)

2. In the File Name box, enter a name for the database.
3. If you want to store the database in a location other than your Documents
folder, do the following:
a. Click the folder icon to the right of the File Name box.
b. In the File New Database dialog box, navigate to the folder where you want
to store the database.
c. Click OK.
4. Click Create. Access downloads the template if necessary, and then creates and
opens the new database.
5. If an Info bar below the ribbon displays a security warning, click Enable
Content.

Import database objects and data
Whether you start with a blank database or base your database on a template, you
can add some or all of your records by importing data. You can also define part of the
structure of the data by, for example, using column headings in a spreadsheet as field
names in a new table. Data sources you can use include Excel workbooks, other Access
databases, text files, XML files, Microsoft SharePoint lists, and Microsoft Outlook
folders.
When you import data, you generally have three options: importing the source data
into a new table, appending the data to a table that’s already defined, or linking to the
data source to create a linked table. When you are importing objects and data as part
of creating a database, you use the first of these options in most cases. Access often
provides wizards that help you provide the information Access requires to import data
from a specific format.
See Also For information about appending data to a table, see “Append records from external
data,” in “Objective 2.3: Manage records in tables.” For information about creating linked
tables, see “Create linked tables,” in “Objective 2.1: Create tables.”
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Options for importing data from an Excel spreadsheet

When you import data from Excel into a new table, the Import Spreadsheet Wizard
prompts you for information to complete the operation. The wizard first prompts you
for the worksheet or the named range you want to import. You can view the sample
data that the wizard displays from the worksheet, but you cannot modify it. Access can
use the column headings in the worksheet as field names in the database. You can also
specify each field’s data type and whether Access should index the field. The wizard’s
fourth page provides options for setting the table’s primary key. Access can create an
ID field in the table to use as the primary key, or you can select a primary key field or
use no primary key in the new table.

10

Objective 1.1: Create and modify databases

1

Define field names and data types when you import data from a spreadsheet

See Also For information about running saved import and export operations, see “Objective
1.5: Print and export data.”
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When you import data from another Access database, you can import all the objects
in that database or only the objects you select. The Import Objects dialog box shows
the tables, queries, forms, reports, macros, and modules in the source database on
separate tabs.

Import options control how the data is imported

The available import options are described in the following list:
■

■
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In the Import area, the Relationships option determines whether table relationships are preserved in the import operation. Selecting the Menus And Toolbars
option imports any custom menus and toolbars from databases created in
versions of Access prior to Access 2007. Selecting Import/Export Specs includes
any import or export specifications defined in the source database. Selecting
Nav Pane Groups imports any custom Navigation Pane groups set up in the
source database, and selecting All Images And Themes includes these elements
with the import.
Options in the Import Tables area control whether you import only the definition
of the database objects you select or both the definition of the object and the
data. For example, you can import a table with its fields and other properties but

Objective 1.1: Create and modify databases

no data or include the data in the table. If you are importing objects to create a
new database, you might want to import only the definition for a table in which
you store project details, but you might want to include the data when you
import a table that stores a set of tasks that is common to all projects.
■

1

The options in the Import Queries area determine whether Access imports a
query as a query or as a table. You might import a query as a table when the
query’s definition (the fields it includes) forms the basis of a table you want in a
new database.

You can import data from a text file that uses the .txt, .csv, .tab, or .asc file name extension. When you import data from a text file, you work with the Import Text wizard. In
the wizard, you first need to specify whether a character separates the fields of data
in the text file (a delimited text file) or whether the data is arranged in fixed-width
columns. For delimited text files, you need to specify which character is used as the
delimiter; for fixed-width files, you indicate where column breaks should occur.
The later pages of the Import Text wizard are similar to those you work with in the
Import Spreadsheet wizard. You can name fields, specify a data type, indicate whether
the field should be indexed, and skip a specific field. The wizard also prompts you to
set up a primary key for the table.
Three of the other formats you can import are as follows:
■

■

■

XML files Access uses the structure of the XML file to determine table names
and fields. Import options include Structure Only, Structure And Data, and
Append Data To Existing Table(s).
SharePoint lists You provide the URL for the SharePoint site, and you might
need to provide your user name and password to gain access to the site. If
Access connects to the site successfully, the lists stored on the site are displayed,
and you can then select the list or lists that contain the data you want to import.
If you select more than one list, each list is imported as a separate table. Access
uses the list’s name for the table name and the list’s columns as the table’s fields.
Outlook folders Importing a contacts or tasks folder from Outlook is an
effective way to add this information to a database. Access runs the Import
Exchange/Outlook wizard when you import data from Outlook. The wizard
prompts you to provide field names, specify data types, and set up indexes. You
can skip fields if you don’t want to import them.

To import data from Excel into a new table
1. On the External Data tab, in the Import & Link group, click Excel.
2. In the Get External Data dialog box, click Import the source data into a new
table in the current database, click Browse to locate the source file, and then
click OK.
13
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3. In the Import Spreadsheet Wizard, select the worksheet or named range that
has the data you want to import.
4. Click Next, and then work through the wizard to specify whether the first
column of the data includes column headings, set field options, designate a
primary key, and name the table.
5. Click Finish in the wizard. If you want to save the steps in this operation, in the
Get External Data dialog box, select Save import steps.
To import data from another Access database
1. On the External Data tab, in the Import & Link group, click Access.
2. In the Get External Data dialog box, click Browse to locate the source database.
3. Click Import tables, queries, forms, reports, macros, and modules into the
current database, and then click OK.
4. In the Import Objects dialog box, do either of the following:
●
●

To import all the objects from the source database, click Select All.
To import only specific objects from the source database, select objects you
want to import.

5. Click Options, and then set the options for the import operation:
●

●
●

In the Import area, click Relationships to preserve table relationships
defined in the source database.
In the Import Tables area, click Definition and Data or Definition Only.
If you are importing queries, in the Import Queries area, click As Queries or
As Tables.

6. In the Get External Data dialog box, do the following:
a. If you want to save the steps of the operation for reuse, select the Save
import steps check box and provide a name and optional description for
the steps.
b. Click Close.
To import data from a text file into a new table
1. On the External Data tab, in the Import & Link group, click Text File.
2. In the Get External Data dialog box, do the following:
a. Click Import the source data into a new table in the current database.
b. Click Browse. Navigate to and select the source file, and then click OK.
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3. In the Import Text wizard, do the following:
a. Specify the format for the file you’re importing (Delimited or Fixed Width),
and then click Next.

1

b. Choose the delimiting character or specify column breaks (depending on
the format selected in step a). Select First Row Contains Field Names if this
option applies.
c. Click Next, and then work through the remaining pages to set field options,
designate a primary key, and name the table.
d. In the Import Text wizard, click Finish.
4. In the Get External Data dialog box, do the following:
a. If you want to save the steps of the operation for reuse, select the Save
import steps check box and provide a name and optional description for
the steps.
b. Click Close.
To import an XML file
1. On the External Data tab, in the Import & Link group, click XML.
2. In the Get External Data dialog box, do the following:
a. Click Browse to open the File Open dialog box. Locate and select the source
file, and then click Open.
b. Click OK to open the Import XML dialog box.
3. In the Import Options area of the Import XML dialog box, do either of the
following, and then click OK:
●

●

To import only the XML file structure as the table’s definition, select
Structure Only.
To import the XML file structure and the data values, select Structure and
Data.

4. In the Get External Data dialog box, do the following:
a. If you want to save the steps of the operation for reuse, select the Save
import steps check box and provide a name and optional description for
the steps.
b. Click Close.
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To import a SharePoint list
1. On the External Data tab, in the Import & Link group, click More, and then click
SharePoint List.
2. In the Get External Data dialog box, do the following:
a. In the Specify a SharePoint site box, enter the URL for the SharePoint site
you want to connect to.
b. Click Import the source data into a new table in the current database, and
then click Next.
3. On the Import data from list page, for each list that you want to import as a
table, do the following:
a. Select the list check box.
b. In the Items to Import list, select All Pages or an option such as Recent
Changes.
c. Click OK.
4. In the Get External Data dialog box, do the following:
a. If you want to save the steps of the operation for reuse, select the Save
import steps check box and provide a name and optional description for
the steps.
b. Click Close.
To import an Outlook folder as a table
1. On the External Data tab, in the Import & Link group, click More, and then click
Outlook Folder.
2. In the Get External Data dialog box, click Import the source data into a new
table in the current database, and then click OK.
3. If multiple mail profiles are configured on your computer, the Choose Profile
dialog box opens. In the dialog box, select the profile you want to import from,
and then click OK.
4. If prompted, enter the user name and password for your Outlook account.
5. In the Import Exchange/Outlook Wizard, do the following:
a. Select the folder you want to import, and then click Next.
b. Make changes to the field names or data types Access assigns to the folder’s
contents, set the Indexed property for a field, or specify to skip a field. Then
click Next.
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c. Choose an option to have Access set a primary key, select your own key, or
set no primary key. Then click Next.

1

d. Change the name of the table if you want to, and then click Finish.
6. In the Get External Data dialog box, do the following:
a. If you want to save the steps of the operation for reuse, select the Save
import steps check box and provide a name and optional description for
the steps.
b. Click Close.

Delete database objects
Access databases depend on the relationship between tables to preserve the integrity
of data and to eliminate redundant data. You can delete most types of database objects,
including queries, forms, and reports, without affecting underlying relationships.
However, Access prevents you from deleting a table that is related to another table without first deleting the relationship. Access deletes the relationship for you if you agree.

A warning about deleting a table

See Also For more information about table relationships, see “Objective 1.2: Manage relationships
and keys.” For information about renaming database objects, see “Back up and restore databases”
in “Objective 1.4: Protect and maintain databases.”

To delete a database object
1. Close the object that you want to delete.
2. In the Navigation Pane, right-click the object, and then click Delete.
3. In the Microsoft Access message box asking you to confirm that you want to
delete the object and remove it from all groups, click Yes.
4. If you are deleting a table and Access prompts you to confirm that you want
Access to delete the relationship, click Yes to remove the relationship and delete
the table.
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Objective 1.1 practice tasks
The practice file for these tasks is located in the MOSAccess2016\Objective1
practice file folder. The folder also contains a result file that you can use to
check your work.

➤ Start Access and do the following:
❑ Create a database from the Desktop contacts template. (Depending

on your installation of Access, the template might be named Contacts
desktop.) Name the database MOSContacts and save it in the practice
file folder.

➤ If you want to explore the contact management database features, play
the Using the Contacts Database video from the Welcome screen.
Tip If the Welcome screen doesn’t open automatically, double-click the
Welcome form in the Navigation Pane.

❑

Close the MOSContacts database without exiting Access.

➤ From the Access Start screen or the New page of the Backstage view,
do the following:

❑
❑

From the search box, locate the Northwind 2007 sample template.

❑

Close the Northwind database without exiting Access.

Create a database from the template. Name the database
Northwind and save it in the practice file folder.

➤ From the Access Start screen or the New page of the Backstage view,
do the following:

❑

Create a blank desktop database. (Depending on your installation
of Access, the template might be named Blank database or Blank
desktop database.) Name the database MOSDatabase and save it in
the practice file folder.

❑

Import the Customers and Orders table definitions (not the data)
from the Northwind database you created.
Tip Display the Options area and, in the Import Tables section, select
Definition Only.
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❑

Import the ExpensesPaid worksheet from the Access_1-1 workbook
located in the practice file folder to create a new table in the
MOSDatabase database, using the worksheet’s column headings.
Use the ExpenseID field as the primary key. Name the table
Expenses.

➤ Open the Access_1-1_results database. Compare the two databases to
check your work. Then close the open databases.
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Objective 1.2: Manage relationships and keys
Formally, Access is known as a relational database management system, or RDBMS. In
this model, relationships between tables maintain the integrity of the data and reduce
the need to store redundant data. For example, customer names can be stored in one
table and orders stored in another. By creating a relationship between these tables,
you relate each order to a customer; you don’t need to repeat the customer’s name in
the record for new orders. Relationships between tables are also used when you base a
query, form, or report on more than one table.

Set options for a relationship in the Relationships window and the Edit Relationships dialog box

This topic describes how to create table relationships, how to set primary keys and
foreign keys in an Access database, and how to display relationships in the Relationships
window.

Create and modify relationships
When you create a table relationship, the type of the relationship depends on the data
that the tables contain and how that data is related. Tables can have the following
types of relationships:
■

20

One-to-many In this relationship, any one record in the first table can be
related to many records in the second table (for example, one customer can
place many orders), but any record in the second table (an order) is related to
only one record in the first table (for example, each order is placed by a single
customer).

Objective 1.2: Manage relationships and keys

■

■

One-to-one In a one-to-one relationship, each record in the first table is
related to only one record in the second table. You can use a one-to-one
relationship to maintain a separate table that defines and stores fields for data
that you don’t refer to regularly or that you want to keep more confidential. For
example, in an Employees table, you can store general employee information
such as first and last name, department, job title, and building and office location. In separate EmployeeRating and EmployeeCompensation tables, you can
store performance ratings and compensation data—information that you want
only certain people or groups to use. Each record in the Employees table has a
single matching record in the table for ratings or compensation.

1

Many-to-many An Orders table and a Products table have a many-to-many
relationship because each record in the Orders table can have many matching
records in the Products table, and each record in the Products table can have
many matching order records. You can’t define a many-to-many relationship
directly. Instead, you need to create a linking table (also known as a junction
table) to create two one-to-many relationships. The linking table includes the
primary key fields from both the other tables.
Tip In the Northwind sample database that comes with Access, the Order Details table
is a linking table.

When you create a relationship, Access displays the Edit Relationships dialog box. If
Access detects matching fields in the tables (for example, if each table has a field named
CustomerID), Access displays these fields in the Table/Query and Related Table/Query
lists. You can replace these default selections when you need to. The relationship type is
indicated at the bottom of the dialog box.

Settings for a one-to-many relationship

See Also For information about join types, see “Create multiple-table queries,” in “Objective
3.1: Create queries.”
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The Edit Relationships dialog box includes several important options, such as the
following:
■

■

Enforce Referential Integrity Referential integrity is used to prevent orphan
records (records in one table with no matching record in a related table) and
to maintain references between related tables. By using referential integrity,
you ensure that no record in one table refers to a record in another table that
doesn’t exist; for example, a record for a book cannot refer to an author if a
record for that author does not exist. If you enforce referential integrity, Access
does not allow operations that violate referential integrity rules for that relationship; for example, you can’t enter a customer ID in the Orders table if that
customer ID does not exist in the Customers table. Also, you can’t delete records
that reflect an existing relationship; for example, you can’t delete a customer
record if order records for that customer exist.
Cascade options When you apply referential integrity to a relationship, you can
choose one or both Cascade options:
●

●

If Cascade Update Related Fields is selected, Access updates the foreign key
for all related fields when you make a change to the primary record.
If Cascade Delete Related Records is selected, Access deletes all related
records when you delete a primary record. If you delete a customer, for
example, Access also deletes all order records for that customer.

In a large database with a web of table relationships, you might need to refine the
view of the relationships in the Relationships window. You can modify the content of
the Relationships window in the following ways:
■

Hide a table to remove it from the window.

■

Select a set of tables you want to view.

■

View the tables with direct relationships for the selected table.

■

View all the relationships in the database.

■

Drag the table thumbnails to alter the arrangement of the window.

When you close the Relationships window, Access prompts you to save the current
layout.
The Object Dependencies pane provides information about how one database object
depends on others and how others depend on it. Although the dependencies displayed are not the same as table relationships, you can use the Object Dependencies
pane to see, for example, which forms depend on the data or fields in a specific table.
Tip The Relationship Report command in the Tools group on the Relationships Tools Design
tool tab produces a printable report of the current layout in the Relationships window.
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To open the Relationships window
➜ On the Database Tools tab, in the Relationships group, click Relationships.

1

To display tables in the Relationships window
1. On the Design tool tab, in the Relationships group, click Show Table.
2. In the Show Table dialog box, select the tables, and then click Add.
Tip Hold down the Ctrl key to select multiple items.

To remove tables from the Relationships window
➜ In the Relationships window, do either of the following:
●

●

To remove one table, click the table to select it. Then on the Design tool tab,
in the Relationships group, click Hide Table.
To remove all tables, on the Design tool tab, in the Tools group, click Clear
Layout.

To display relationships in the Relationships window
➜ In the Relationships window, do either of the following:
●

●

To display all direct relationships of a specific table, click the table to select
it. Then on the Design tool tab, in the Relationships group, click Direct
Relationships.
To display all relationships in the database, on the Design tool tab, in the
Relationships group, click All Relationships.

To view object dependencies
1. In the Navigation Pane, select the database object whose dependencies you
want to view.
2. On the Database Tools tab, in the Relationships group, click Object
Dependencies.
3. In the message box informing you that Access needs to update dependency
information, click OK.
4. In the Object Dependencies pane, click Objects that depend on me or Objects
that I depend on.
To create a table relationship
1. Open the Relationships window. If the tables you want to create relationships
between aren’t displayed in the Relationships window, add them.
2. Drag the linking field from the first table (the “one” table in a one-to-many
relationship) to the second table (the “many” table).
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3. In the Edit Relationships dialog box that opens, do the following:
a. Ensure that the linking fields are selected in the Table/Query and Related
Table/Query lists.
b. If you want to enforce referential integrity for this relationship, select the
Enforce Referential Integrity check box.
c. If you enforce referential integrity, you can also do one or both of the
following:
۵

۵

If you want Access to update related fields when you change the primary
record, select the Cascade Update Related Fields check box.
If you want Access to delete related records when you delete the primary
record, select the Cascade Delete Related Records check box.

d. Click Create to establish the relationship and close the dialog box.
To modify a relationship
1. Open the Relationships window and do either of the following:
●

●

Click the relationship line between two tables. Then on the Design tool tab,
in the Tools group, click Edit Relationship.
Right-click the relationship line between two tables, and then click Edit
Relationship.

2. In the Edit Relationships dialog box, modify the table or query selections, the
join type, or the options, and then click OK.

Set key fields
In Access, key fields are used when you establish table relationships. For example, if you
have a table named Project Managers, the table could include the ProjectManagerID
field as its primary key. A table’s primary key uniquely identifies each record in the
table. You can then add the ProjectManagerID field to the Projects table to create a
relationship between the tables that lets you identify the manager for each project. In
the Projects table, the ProjectManagerID field is referred to as a foreign key. Primary keys
and foreign keys can also be used in queries to join tables; Access uses that relationship
to retrieve the set of records that match the criteria you define.
You can use a single field (for example, a unique product or customer code, or an ID
field that is set to the AutoNumber data type that Access provides) or a combination
of fields as a table’s primary key. A multifield primary key is called a composite key.
For an AutoNumber field, Access assigns a unique number to each record in a table;
you don’t need to keep track of values that might be duplicates. If you don’t use the
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AutoNumber data type but instead use a field whose value you enter, be sure that you
set the field’s Required property to Yes and that you use a field or a combination of
fields whose values change infrequently or not at all.

1

See Also For information about setting field properties, see “Objective 2.4: Create and modify
fields.”
Tip When you create a new table, Access includes an ID field in the table and sets this field to
be the table’s primary key.

A foreign key field should be set to the Number data type. You do not need to enter
data for the foreign key field. Instead, the field’s values are tied to the unique values
from the table in which the field is the primary key field.
To set the primary key for a table, you must have the table open in Design view. Access
adds a small key icon to the row selector area to indicate that a field is a primary key
field.

A key icon identifies the primary key field

If a table already contains data, the field or fields you designate for the primary key
must have unique values. Also, if a primary key field is part of any table relationship,
you must remove the relationship before you can change the primary key.
See Also For information about adding and deleting relationships, see “Create and modify
relationships” earlier in this topic.
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To open a table in Design view
➜ If the table is closed, right-click the table in the Navigation Pane, and then click
Design View.
➜ If the table is open in another view, on the Design tool tab, in the Views group,
click View, and then click Design View.
See Also For more information about object views, see “Change object views” in “Objective
1.3: Navigate through a database.”

To set a primary key
1. Open the table in Design view.
2. Select the field or fields you want to designate as the table’s primary key. To
select multiple fields, press Ctrl and select the fields.
3. On the Design tool tab, in the Tools group, click Primary Key.
To remove the primary key designation from a field
1. Open the table in Design view.
2. Select the field or fields from which you want to remove the primary key
designation.
3. On the Design tool tab, in the Tools group, click Primary Key.
To set a foreign key in a table
1. Open the table in Design view.
2. In the Field Name column, enter the name of the foreign key field.
3. In the Data Type column, select Number.
4. Save the changes to the table.
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Objective 1.2 practice tasks
The practice file for these tasks is located in the MOSAccess2016\Objective1
practice file folder. The folder also contains a result file that you can use to
check your work.

➤ Open the Access_1-2 database from the practice file folder, and then do
the following:

❑
❑
❑

Open the Status table in Design view.
Set the StatusID field as the table’s primary key.
Save the changes to the table.

➤ Open the Relationships window and do the following:
❑ Display the Tasks and Status tables in the window.
❑ Create a relationship between the Status table (StatusID field) and
the Tasks table (Status field).

❑

Use the Show Table command to add the Compensation table to
the Relationships window.

❑

Edit the relationship between the Compensation table and the
Employees table to enforce referential integrity.

➤ Open the Access_1-2_results database. Compare the two databases to
check your work. Then close the open databases.
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Objective 1.3: Navigate through a database
In an Access database, navigational features can be different for users who are responsible for designing and maintaining the database and for users whose role is only to enter,
edit, and view data. Later in this topic, you examine how to create a navigation form
that greets database users when they open a database and provides a set of controls for
opening forms, running queries, and viewing and printing reports. In this topic, you also
study how to find specific records, set up different views in the Navigation Pane, and
work with basic Access views.

Navigate specific records
You have a choice of tools when you need to find a specific record in a table or in the
results of a query, or when you’re working with a form or report. Navigation buttons
that appear at the bottom of a form or a table in Datasheet view move from record
to record or to the first or last record. The record indicator displays which record is
selected. The navigation area also includes a simple search box in which you can enter
the text you want to search for. Access finds the first instance of that text in any of the
object’s fields.

Use the search box in the navigation area to find specific records
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On the Home tab, commands in the Find group help you locate records, perform
find-and-replace operations, and move between records by using the Go To options.
In the Find dialog box, you can select an option to search the current field or the
current document (the full database). The Match box provides options for matching
the whole field, any part of the field, or the start of the field. For example, if you were
searching for records for pasta, you could enter pasta and match the whole field, pa
and match the start of the field, or st and match any part of the field. You can also
conduct case-sensitive searches. The Search Fields As Formatted check box is selected
by default. You can clear this option to search for values as Access stores them rather
than as they are formatted in the database.

1

Another approach for navigating to a specific record is to use the options that Access
provides for sorting and filtering records. You can sort the records in text fields in
ascending or descending order, and in number fields from smallest to largest or largest to smallest. When you filter records, only the records that match the filter’s criteria
are displayed. This reduces a long list of records to just a few records among many.
See Also For information about sorting and filtering records, see “Find, sort, and filter data” in
“Objective 2.3: Manage records in tables.”

To use the navigation area
➜ In the navigation area at the bottom of a table, query, or form, use the arrows to
move to the first, next, previous, or last record in the record set.
➜ To find a specific record, in the navigation area’s search box, enter text related to
the record.
To go to a record
➜ On the Home tab, in the Find group, click Go To, and then click First, Previous,
Next, or Last.
To find records
1. On the Home tab, in the Find group, click Find.
2. In the Find And Replace dialog box, in the Find What box, enter text related to
the record you want to locate.
3. Use the Look In, Match, and Search lists and the Match Case option to specify
conditions that Access will use to locate records.
4. Click Find Next.
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Create and modify navigation forms
To augment or replace the Navigation Pane, you can build a form that database users
use to open forms, run queries, view reports, and perform other database operations.

A simple navigation form

Access provides several default layouts for navigation forms. Each of the built-in layouts
provides tabs (in various locations and orientations) that users click to display the
object they want to use. You can add other forms and reports to the navigation form to
complete it. As you add objects to the navigation form’s tabs, Access duplicates the Add
New tab, to mark where the next object tab will appear. You can also insert a navigation
button to add a link in a specific position.
To create a navigation form
1. On the Create tab, in the Forms group, click Navigation, and then click the
layout you want to use.
2. Expand the Navigation Pane if it is collapsed.
3. Drag the first database object (a form or report, for example) that you want to
add to the navigation form from the Navigation Pane to the Add New area of
the navigation form.
4. For each additional object that you want to add to the form, drag the object
from the Navigation Pane and drop it before or after an existing tab.
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5. To create a navigation tab that isn’t linked to a specific object, do either of the
following:
●

●

1

To insert a tab after the existing tabs, double-click the [Add New] tab, and
then click away from it.
To insert a tab between others, right-click the tab that is currently in the
position you want for the new tab, and then click Insert Navigation button.

6. In the content area of the program window, right-click the form tab, and then
click Save.

Set a form as the startup option
After you create a navigation form, you can select it as the default form that Access
displays when you open the database. You can use this option to designate any form
in your database as the default form to display. You don’t need to select a navigation
form.
To specify a startup form
1. Open the Access Options dialog box and display the Current Database page.
2. In the Application Options section, open the Display Form list, and click the
form you want to use.

Display objects in the Navigation Pane
This section focuses on the Access Navigation Pane and how you can modify and
organize it to display different views of the objects in a database. The ability to modify
the Navigation Pane means that it can serve the needs of a range of users—from a
database’s designer to its casual users.
The Northwind sample database provides examples of how you can configure the
Navigation Pane. In the Northwind database, objects by default are arranged within
several categories, not by object name or object type. Objects are grouped under
headings such as Customers & Orders, Suppliers, and Shippers instead of headings
such as Tables, Queries, and Forms. Headings such as Customers & Orders help clarify
functional areas of the database and help users find forms and queries related to the
area they are working with.
When you change how database objects are displayed in the Navigation Pane, you
work with a menu that has several options. This menu arranges commands in two
areas, marked by the shaded labels Navigate To Category and Filter By Group. The
Navigate To Category area includes categories such as Object Type, Tables And
Related Views, Created Date, and Modified Date. For each category, the Filter By
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Group area provides options that you can apply to display a subset of objects. For
example, if you select Modified Date in the Navigate To Category area, you can then
filter the list by selecting Today, Three Weeks Ago, Yesterday, Older, or All Dates. For
the Object Type category, you can filter the Navigation Pane to view only objects of a
specific type or view all objects.
The Tables And Related Views category displays each table in the database together
with other database objects that depend on it. Using this view is helpful when you
make changes to a table’s design. For example, by choosing the Tables And Related
Views category and then choosing a single table in the Filter By Group area, you can
see which objects depend on the table, and you can review the design of those objects
to be sure that the changes you want to make to the table won’t affect the other
objects in ways you don’t intend.
You can also sort the list of objects in a category, showing them in ascending or
descending order or by name, type, and date criteria. You can also change the level of
detail that is shown for objects in the Navigation Pane. You can display a list of names
with a small icon, show a larger icon next to the name of the object, or show details
such as the created and modified date for the object.
The search bar at the top of the Navigation Pane helps you locate a specific object (or
group of objects) by name. As you enter a text string, Access filters the list of objects
and displays those that match.
As with the Northwind sample database, database templates often provide a specific category for viewing database objects by functional role. For example, the Task
Management template provides a category called Tasks Navigation, which lets you filter
by groups such as tasks and contacts. A blank desktop database includes a category
named Custom that you can rename and use to build your own Navigation Pane view.
You can set up Navigation Pane categories and groups of your own in the Navigation
Options dialog box.
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Organize the Navigation Pane into categories and groups

The categories defined for the database appear in the list at the left, and each group
defined for a category appears in the list at the right. You can hide a group from being
displayed in the Navigation Pane, or select display options to show hidden and system
objects in the Navigation Pane or to show or hide the search bar. By using the Open
Objects With options, you can control whether an object opens when it is clicked
(similar to a hyperlink) or double-clicked.
In the Groups For list is a group named Unassigned Objects, which is a built-in group
that contains all the objects in a database. When you work with the default Custom
category in a blank database, Access also provides a group named Custom Group 1.
Tip You can reposition a custom category or group by using the arrows that appear beside
an item’s name when you select it. You cannot place a custom category above the two built-in
categories or place a custom group below the built-in group Unassigned Objects.

When you add a database object to a custom group, you add only a shortcut to that
object, not the object itself. This means that you can delete a shortcut from a custom
group without deleting the database object.
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To create and modify Navigation Pane categories and groups
1. Right-click the Navigation Pane title bar, and then click Navigation Options.
2. In the Navigation Options dialog box, do any of the following, and then click OK:
●
●

●

●

●

●

To add a category, click Add Item and then enter a name for the category.
To rename the selected category, click Rename Item, edit the name, and
then press Enter.
To delete the selected category, click Delete Item, and then in the message
box asking you to confirm the deletion, click OK.
To add a group to the selected category, click Add Group, and then enter a
name for the group.
To rename the selected group, click Rename Group, edit the name, and then
press Enter.
To delete the selected group, click Delete Group, and then in the message
box asking you to confirm the deletion, click OK.
Tip You can rename and delete only custom groups.

●

●

In the Display Options area, select or clear the check boxes for showing
hidden objects, system objects, and the search bar.
In the Open Objects With area, click Single-click or Double-click.

To add objects to a group
1. In the Navigation Pane, display the Unassigned Objects group.
2. Right-click the object you want to add to the group, click Add to group, and
then select the group.

Change object views
You work with database objects in a variety of views. Each type of object (tables, queries, forms, and reports) can be opened in Design view. In Design view, you can add
and define fields and field properties for a table; add fields to a query; add command
buttons, list boxes, and other controls to a form; and apply formatting, group records,
add calculated fields, and complete other tasks when you work with reports.
Forms and reports can also be opened in Layout view. In Layout view, you can design
and modify a form or report while viewing the actual data. In Design view, data is not
displayed. When you work with a form (for data entry or when searching for a specific
record), the form is displayed in Form view. When you view a completed report, the
report is displayed in Report view.
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When you open a table for data entry or view the results that a query returns, you
work with the table or query in Datasheet view.

1

To change object views
➜ In the Navigation Pane, right-click the object and then choose the view you
want to use. (Not every object view is available on the menu.)
➜ With the database object open, right-click the object’s tab in the Access design
window, and then select the view you want to use.
➜ With the database object open, click View on the object’s Design tool tab, and
then select the view you want to use. (For tables, the View command appears on
the Fields tool tab.)
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Objective 1.3 practice tasks
The practice file for these tasks is located in the MOSAccess2016\Objective1
practice file folder. The folder also contains a result file that you can use to
check your work.

➤ Open the Access_1-3 database from the practice file folder, and then do
the following:

❑

Open the Customers table in Datasheet view. Use the search box to
locate the record for The Big Cheese.

❑

Create a Navigation Pane category named Campaigns, and groups
named Campaign Details, Products, and Employees.

❑

Add the Campaign Expenses, CampaignLanguages, and Marketing
Campaigns tables to the Campaign Details group. Add the Orders
and Products tables to the Products group, and add the Employees
table to the Employees group.

❑

Create a navigation form that has the Vertical Tabs, Left layout. Add
the TaskDetails form to the navigation form. Save the form (use the
default name for this practice task), and then set the form as the
startup form.

➤ Open the Access_1-3_results database. Compare the two databases to
check your work. Then close the open databases.
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Access provides several options for maintaining and protecting a database. The first of
these—Compact & Repair—can help improve the performance of a database and can
repair database files in the event of a problem. You can use the Encrypt With Password
option to restrict database access to only those users who know the password.
This topic describes these options and other tasks you perform to protect and maintain a database, including backing up a database, recovering data from a backup, and
splitting a database—a step that applies especially to a database shared by multiple
users.

Compact and repair databases
As you and other users work with an Access database, the database file grows larger
as you add data and because Access creates and uses hidden objects to perform its
work behind the scenes. Database files can also become corrupt. Frequent use of the
database—especially by multiple users working on the database over a network—can
result in a corrupted file, which can in some cases result in data loss or affect the ease
with which you can change the database’s design.
To keep ahead of these potential problems, you can compact and repair a database.
You can perform these operations on the current database (the database you have
open) or select a different database when you perform these operations.
Some restrictions apply to compacting and repairing a database. For example, if
more than one person has the database open when you compact or repair it, Access
displays a message indicating that you attempted to open a database that is already
open. Before you compact a multiuser database, you should be sure that no one has
the database open and then open the database for exclusive access.
Tip Select the Compact On Close option on the Current Database page of the Access Options
dialog box to compact a database each time you close it.

To open a database for exclusive access
1. If the database is open, click the File tab, and then click Close. (If other users
have the database open, they must also close the database.)
2. Display the Open page of the Backstage view. In the Places list, click the location where the database is stored, such as This PC. Then click Browse.
3. In the Open dialog box, navigate to the folder where the database is stored, and
then select the database.
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4. Click the Open arrow, and then click Open Exclusive.

Opening a database for exclusive access

To compact and repair the current database
1. Open the database for exclusive access.
2. On the Info page of the Backstage view, click Compact & Repair Database.
To compact and repair a database that isn’t currently open
1. Close any open databases.
2. On the Database Tools tab, in the Tools group, click Compact and Repair
Database.
3. In the Database to Compact From dialog box, select the database you want to
compact, and then click Compact.
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4. In the Compact Database Into dialog box, enter a name for the compacted
database, and then click Save.

1

5. If you used the current name of the database, click Yes in the message box
Access displays to confirm that Access should replace the current database file.

Back up and restore databases
Another step in protecting your database files from corruption and the potential
loss of data is to perform regular backups. In practice, you need to back up some
databases more often than others. A database that serves as an archive, for example,
and isn’t used frequently, doesn’t need to be backed up on a specific schedule. A
database that you and others work with nearly every day should be backed up on a
regular schedule. You should also follow standard backup procedures such as keeping
the backup copies on external media (such as a DVD or a flash drive) and in a secure
location.
Exam Strategy The objective domain for this exam includes backing up a database and
recovering database objects from a backup. You might be required to demonstrate the
recovery of specific objects, such as tables.

When you back up a database, Access appends the current date to the name of the
database file. You can retain this date or replace it with an alternative identifier. You
might also add “backup” to the file name so that you can identify a backup easily.
If one or more objects in a database become corrupt, if you lose data, or if you need
to return to an earlier version of a database for some other reason, you can restore
a database by replacing it with a backup file. You can also recover specific database
objects by importing them from a recent backup.
IMPORTANT You might be able to at least partially repair a corrupt database by running the
Compact & Repair command. For information, see “Compact and repair databases” earlier in
this topic.

Recovering an object from a backup doesn’t automatically replace the original object.
For example, if you restore a table named Tasks from a recent backup, Access creates
a table named Tasks1 in the current database. Before you begin the steps to recover a
database object, you should delete the object from the current database or rename
the original object (by adding an identifier such as “old” or “bad”).
To back up a database
1. Display the Save As page of the Backstage view.
2. In the Advanced area, click Back Up Database, and then click Save As.
3. In the Save As dialog box, modify the file name that Access provides (or accept
the default name), and then click Save.
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To rename a database object
1. In the Navigation Pane, right-click the object, and then click Rename to activate
the object name for editing.
2. Enter the new object name, and then press Enter.
See Also For information about deleting database objects, see “Delete database objects” in
“Objective 1.1: Create and modify databases.”

To restore database objects from a backup
1. Open the database in which you want to restore an object.
2. In the Navigation Pane, rename or delete the current instance of the object. (If
you are restoring a missing object, you can ignore this step.)
3. On the External Data tab, in the Import & Link group, click Access.
4. In the Get External Data dialog box, click Import tables, queries, forms,
reports, macros, and modules into the current database.
5. Click Browse and navigate to the backup file you want to use. Then click Open.
6. In the Get External Data dialog box, click OK.
7. In the Import Objects dialog box, do either of the following, and then click OK:
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Click Select All to select all the objects and restore the entire database.

●

Select the object or objects you want to restore.
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Restoring database objects from a backup

8. In the Get External Data dialog box, click Close.

Split a database
You can think of an Access database as composed of two parts. The tables, which define
and store the raw data, make up one part (the back end). The second part consists of the
queries, forms, reports, and supporting objects that users interact with to enter, edit, and
view data (the front end). You can split a database to store the tables in one file and the
other database objects in a second file. Splitting a database into a front end and back
end allows the database designers and administrators to create new forms or update
reports for the front end without interfering with the use of the back-end database
while doing so. When the new objects are ready, the administrators can implement the
updated front end without affecting the relationships and references in place in the
back end.
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Another reason to split a database is to reduce network traffic when the database is
used by more than one person. The back-end database (the tables) can reside in a
shared location, and each person can use a local copy of the front-end database.
Tip You should back up your database before you split it.

After you split a database, Access displays a small arrow icon in the Navigation Pane
next to the names of tables.

The arrows in the Navigation Pane indicate tables that are linked to the back-end database

To split a database
1. Close all open database objects.
2. On the Database Tools tab, in the Move Data group, click Access Database. If
Access displays a security notice that shows the path to the file ACWZTOOL.
ACCDE, click Open to proceed and open the Database Splitter dialog box.
3. In the Database Splitter dialog box, read through the information provided,
and then click Split Database.
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The Database Splitter

4. In the Create Back-end Database dialog box, choose a location for the backend file. By default, Access uses the current database name and adds _be to the
end of the file name.
5. Click Split to begin the process. When the process completes, in the Database
Splitter message box confirming that the database split was successful, click OK.

Encrypt database files
When you assign a password to a database, any user who wants to work with the database must enter the password to open the file. You can use this process, for example,
to restrict who can open a database that is stored in a location that many users share.
A database must be open for exclusive use before you can encrypt the database by
using a password. If you are encrypting the current database, you need to close it
before you open it for exclusive use.
IMPORTANT If any properties of the database are incompatible with encryption, Access
displays a message box telling you that the feature (such as row-level locking) will be ignored.
You can safely dismiss this message and proceed with encryption.
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You can also remove a password from a database after you open it for exclusive use.
To encrypt a database with a password
1. Close the database without exiting Access.
2. Display the Open page of the Backstage view.
3. In the Places list, click the drive where the database is stored, and then click
Browse.
4. In the Open dialog box, navigate to the database storage location and select
the database file. Click the Open arrow, and then click Open Exclusive.
5. On the Info page of the Backstage view, click Encrypt with Password.
6. In the Set Database Password dialog box, enter the password you want to
use, enter the password again in the Verify box, and then click OK.

Enter a password to protect the database

To remove a database password
1. Open the database for exclusive access, and enter the database password.
2. On the Info page of the Backstage view, click Decrypt Database.
3. In the Unset Database Password dialog box, enter the password applied to the
database, and then click OK.
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Objective 1.4 practice tasks
The practice file for these tasks is located in the MOSAccess2016\Objective1
practice file folder. The folder also contains a result file that you can use to
check your work.

➤ Open the Access_1-4 database from the practice file folder for exclusive
use, and then do the following:

❑
❑
❑
❑
❑
❑
❑
❑

Log on by using any user name.
Create a password for the database. Use the password Access2016.
Compact and repair the database.
Create a backup of the database. Name the backup MOSBackup.
Rename the Customer List form as Customer List_old.
Restore the Customer List form from the MOSBackup database.
Delete the Customer List_old form.
Split the Access_1-4 database to create a front-end database and a
back-end database. Save the back-end database in the practice file
folder using the default name Access_1-4_be.

➤ Open the Access_1-4_results database. Compare the two databases to
check your work. Then close the open databases.
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Objective 1.5: Print and export data
You can use the data you store in Access in several ways. Within Access, you can create
reports, for example, and distribute the reports in printed or electronic format. You
can also export data to formats that are compatible with earlier versions of Access and
with other programs, including Microsoft Excel and Word.
This topic first focuses on how to print reports and specific database records. It then
describes how to export data from Access and how to save a database as a template.

Print reports and records
When you print a report, you can send the report directly to the default printer
(without setting any printing options), use the Print dialog box to select a printer and
set printing options, or work in print preview, a view that enables you to refine the
report’s layout, view the report in different ways, and export the data.

A report open in print preview

The Print dialog box provides standard options with which you can specify a page
range, set the number of copies, and adjust the page setup. It also provides an option
for printing selected records. You must select the records you want to print before
opening the Print dialog box. In general, you will print records that you select in a
table or query that is open in Datasheet view.
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When you display a report in print preview, Access provides commands to adjust
page size and margins, change the page layout and page orientation (switching from
portrait to landscape, for example), set up the report in columns, and view the report
by zooming in and out or by displaying one or more pages. With these views, you
can assess whether the report’s formatting is consistent, for example, or whether any
important data might be missing. Many of the commands on the Print Preview tab are
also available when you design and format a report in Design view or Layout view.

1

Tip The Print Preview tab also provides a set of options (in the Data group) for exporting data
to other programs or in various formats. These options are described in “Export data” later in
this topic.

In the Page Size group on the Print Preview tab, the Show Margins option displays or
hides the report’s margins, and the Print Data Only option removes elements such as
column headings and information in page headers and footers from the report that
Access prints. You can open the Page Setup dialog box from the Page Size group, but
many of the options in the Page Size and Page Layout groups duplicate options that
the dialog box provides.
The range of zoom levels in print preview extends from 10 percent to a maximum of
1,000 percent (not all zoom levels apply to every object), but you can choose only
preset options (such as 75% or 200%). The Zoom slider, in the lower-right corner of
the Access window, adjusts the zoom level with greater flexibility. The Zoom group
also lets you choose how many pages to display in a multipage report or printout. By
default, one page is displayed. You can also display 2, 4, 8, or 12 pages.
To print a report directly to the default printer
➜ Right-click the report, and then click Print.
Or

1. Open the report from the Navigation Pane.
2. On the Print page of the Backstage view, click Quick Print.
To set printing options and print a report
1. Open the report from the Navigation Pane.
2. On the Print page of the Backstage view, click Print.
3. In the Print dialog box, set options for the print range, number of copies, and
other printer properties. Then click OK.
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To print selected records from a table or a query
1. Open the table or query in Datasheet view.
2. Select the records you want to print.
3. On the Print page of the Backstage view, click Print.
4. In the Print dialog box, do the following:
a. In the Print range area, click Selected Records. (If you don’t click Selected
Records, Access prints all the records in the datasheet.)
b. Click OK.
To manage print and page setup options for a database object in print preview
1. Open the database object you want to print, if it is not already open.
2. On the Print page of the Backstage view, click Print Preview.
3. In the Page Size group, adjust paper size and margins and specify whether
only data should be printed.
4. In the Page Layout group, set the page orientation, columns, and other page
setup options.
5. In the Print group, click Print.
6. In the Print dialog box, set options for the number of copies and other printing options, and then click OK.

Save a database as a template
As described earlier in this chapter, you can use a template as the basis for a new database. The template can provide a set of default database objects (tables, forms, and
reports, for example) that you customize for the needs of a specific database.
You can also save a database that you create (either from scratch or by using a template) as a template. You might use this option to save a basic contact database that
includes information you need in more than one database. You might also create a
set of forms with a look and feel that you want each database to include and then
save those forms as a template. By default, templates are stored in your user profile,
in \AppData\Roaming\Microsoft\Templates\Access.
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Settings for a user-defined database template

In the Create New Template From This Database dialog box, you can categorize the
templates you create. Access sets the Category box to User Templates by default, but
you can define a category of your own and assign a template to it. If you plan to share
this template with other users or just want to add a professional touch to a template
you’re creating for yourself, you can specify an image file to use as an icon for the
template. This icon replaces the standard Access icon in the program’s application
window and as the thumbnail preview of the template that appears in the Backstage
view. You can also specify a preview image and a form that appears when the database opens. If the database you are saving as a template already includes data, you
can include that data in the template or include only the database objects themselves,
without any data.
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The Instantiation Form list specifies the form you want to display as a splash screen, for
example. Access displays the form you select in this list only once and then deletes the
form. Be careful not to confuse this option with a startup form, which you can specify
for the current database by using the Access Options dialog box.
You can include the template as an application part, which makes it available in the
Application Parts gallery on the Create tab. The application part appears under the
heading you provide in the Category box in the Create New Template From This
Database dialog box. The template is also available on the Access startup screen or on
the New page in the Backstage view.
To save a database as a template
1. Create and format the database objects you want to include in the template.
Enter any data you want the template to store by default.
2. Click the File tab, and then click Save As. In the Database File Types list, click
Template, and then click Save As.
3. In the Create New Template from This Database dialog box, enter a name and
description for the database, and then specify a category, icon image, preview
image, and instantiation form (if you want to use one).
4. Select the Application Part check box to add this template to the Application
Parts gallery, and then specify a primary table for the template.
5. Select Include All Data in Package as applicable.

Export data
One of the advantages of entering and maintaining data in a database is the capability
to make the data available in other formats. For example, you can export data to use
it in other programs and in other contexts. Data related to sales, budgets, orders, and
other financial records can be exported to Excel for analysis. A list of contacts can be
exported to a list in a SharePoint site or used in a mail merge in Word. Exporting data
to a text file or to an XML file puts the data in a format that is compatible with other
database and spreadsheet programs, and creating a PDF or an XPS file by using an
export operation lets you distribute data in formats designed for review instead of
analysis and editing.
The Export dialog box provides options to maintain an object’s formatting and layout
when you export it, view the exported file when the operation is complete, and export
only selected records (in lieu of the complete record set that is contained in a specific
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table or query, for example). Specific operations, such as exporting to a text file,
require you to set additional options that control where and how data is exported. You
can also save export settings and then repeat an export operation in a single step.

1

Exporting data to an Excel workbook

The default setting for exporting data to Excel is the Excel Workbook file format
(.xlsx). The options you can choose for a file format depend on the type of object
you export. When you export records from a query, for example, you can keep Excel
Workbook (.xlsx) or choose Excel Binary Workbook, Microsoft Excel 5.0/95 Workbook,
or Excel 97–Excel 2003 Workbook. If you export a report, the file formats are limited to
Microsoft Excel 5.0/95 Workbook and Excel 97–Excel 2003 Workbook.
The availability of export options also depends on the type of object. If you export a
report, the Export Data With Formatting And Layout check box is selected by default
and cannot be cleared. If you export a query or a table, you can select or clear the
formatting and layout check box. By selecting that check box, you can open the destination file, and if you selected a subset of the records, you can then select the option
to export only those records.
If you export an object’s complete record set, Access displays another dialog box,
which has an option for saving the export steps. Saving the export steps saves time
if you expect to run this export operation again using the same object and the same
export settings.
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When you export data to a text file, the steps you follow depend on whether you select
the Export Data With Formatting And Layout option. When you select this option,
Access displays the Encode As dialog box, which provides a choice of encoding schemes:
Windows (Default), MS-DOS, Unicode, or Unicode (UTF-8). The Windows (Default) and
MS-DOS options apply to text files that will be used only in programs that support these
formats. Most programs consuming text files can use files encoded with the Unicode
option. Unicode (UTF-8) is a format used widely on the web.
If you don’t select the Export Data With Formatting And Layout option, Access displays
the Export Text Wizard. In export operations that rely on the Export Text Wizard, you
specify whether to export the data as a delimited text file or as a fixed-width text file.

The Export Text Wizard

From this point, the Export Text Wizard displays screens that refine your initial choice.
For example, for delimited text files, you specify the character that separates fields in
each record (often a comma), whether to include field names in the first row of the
exported file, and the text qualifier character (which is used to handle instances of the
delimiting character that appear in actual values). For fixed-width exports, you use the
wizard to indicate where field breaks occur by dragging lines to create columns.
When you export data to an XML file, you have the option to also export the schema
for the data (an XSD file) and the presentation of the data (which is defined in an XSL
file). For the data, you can export records in related tables in addition to the data in
the object you selected. You can also specify an encoding scheme (UTF-8) or (UTF-16).
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Among the options related to exporting the schema are whether to include table and
field properties and whether to embed the schema in the XML file or create a separate schema document. Presentation options include the location where the XLS file
is stored, where related images are stored, and whether the XSL transformation is run
from a client or a server computer. In the Run From area, the Client option creates an
HTML file on the local computer that programmatically merges the XSL file and the
data (XML) file. This option does not embed the presentation information in the data,
which lets you update either the XSL file or the XML file without having to run the
export operation again. The Server (ASP) option creates an Active Server Pages (ASP)
file that merges the presentation with the data and sends the HTML file that is created
to the local computer.

1

You can export database objects to another Access database or in the following
formats:
■

■

■

For a PDF or XPS file, you can export all the object’s data, selected records, or
specific pages from a report. Both formats also provide options for accessibility.
The Email option in the Export group attaches a database object to email
messages in a format that you select.
You can export the data in an object to use in a mail-merge operation in Word
(the data becomes the recipient list associated with the mail merge) or save the
data as a rich-text format (RTF) document.

If you expect to use an export operation regularly, you can save the export steps you
defined. By saving the export steps, you can run the operation in a single step.

Select the Save Export Steps check box to later perform the export in a single step

When you want to run a saved export in Access, on the External Data tab, in the
Export group, click Saved Exports. Access opens the Manage Data Tasks dialog box.
This dialog box provides options to run the export, create an Outlook task, modify the
name or description provided earlier, and delete any saved exports (or saved imports)
that you no longer need.
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To export data from Access
1. Open the object that contains the data you want to export.
2. On the External Data tab, in the Export group, click the format or program you
want to export to.
3. In the Export dialog box, specify the file name and location, and select the
export options you want to use: to include formatting and layout, to view the
exported file, and to export only selected records.
4. Depending on the export option you select in step 2, use the options in the
dialog boxes and the wizards Access provides to specify file format and related
export options.
To save export steps
1. In the Export dialog box, select Save export steps.
2. Enter a name for the export steps (or accept the default name) and enter a
description.
3. If you want, select Create Outlook Task.
4. Click Save Export.
To run a saved export
1. On the External Data tab, in the Export group, click Saved Exports.
2. In the Manage Data Tasks dialog box, select the export operation you want to
run, and then click Run.
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Objective 1.5 practice tasks
The practice file for these tasks is located in the MOSAccess2016\Objective1
practice file folder. The folder also contains a result file that you can use to
check your work.

➤ Open the Access_1-5 database from the practice file folder and do the
following:

❑

Open the Customers report from the Navigation Pane, and then
display the report in print preview. Change the margins to Wide.

❑

Export the Customers report to Word (use the Rich Text format
option).

❑
❑

Export the Customers table to Excel.
Save the Access_1-5 database as a template. Save the template in a
custom category you create named MOSAccessSamples.

➤ Open the Access_1-5_results database. Compare the two databases to
check your work. Then close the open databases.
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